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Cannot	display	pdf	is	of	invalid	format

Save	the	form	to	your	computer	before	completing	it	We	suggest	that	you	first	download	the	PDF	form	to	your	computer	or	network	drive,	and	then	open	it	with	Adobe	Reader	and	fill	it.	You	can	either	type	information	directly	into	each	field,	or	copy	and	paste	text.	The	font	is	preselected	and	cannot	be	changed.	You	can	only	type	regular	text	(upper
and	lower	cases);	the	system	will	not	accept	underlined	text,	bold	or	italics,	script	or	formulas,	curved	or	slanted	apostrophes,	double	quotation	marks	or	long	dashes.	You	can	save	your	data	and	re-open	the	file	later	to	modify	or	enter	additional	information.	Use	the	latest	version	of	Adobe	Reader	To	open	and	complete	the	PDF	application	forms,	you
will	need	Adobe	Reader	(the	latest	version	is	recommended).	If	you	do	not	have	it	installed	on	your	computer,	you	may	download	the	latest	version	free	of	charge	from	.	Mac	users:	don’t	use	Preview	For	Macintosh	system	users:	DO	NOT	use	the	Preview	program	to	fill	in	the	PDF	form.	Adobe	Reader	is	the	only	program	that	will	allow	you	to	work	with
the	form	properly,	and	allow	us	to	read	the	results	once	back	on	a	Windows	machine.	If	you	do	not	already	have	Adobe	Reader,	please	use	the	link	above	to	install	it	to	your	machine.	Chrome	users:	don’t	use	Chrome	PDF	Viewer	For	Chrome	browser	users:	DO	NOT	use	the	Chrome	PDF	viewer	program	to	fill	in	the	PDF	form.	Adobe	Reader	is	the	only
program	that	will	allow	you	to	work	with	the	form	properly.	If	you	do	not	already	have	Adobe	Reader,	please	use	the	link	above	to	install	it	to	your	machine.	Please	use	the	instructions	below	to	disable	Chrome	PDF	viewer	in	your	browser.	Turn	off	in-browser	viewing	If	you	are	having	problems	using	the	form	via	your	browser,	use	the	instructions
here	to	turn	off	in-browser	PDF	viewing:	�	Or,	try	the	instructions	below.	Print	only	when	your	cursor	is	not	in	a	form	field	Use	your	mouse	to	select	an	area	of	the	form	that	is	not	inside	a	form	field	or	hit	the	tab	key	after	completing	the	entry	of	your	last	box	before	printing	your	form.	If	a	form	field	is	active	(e.g.	contains	the	blinking	bar)	the
contents	of	that	block	will	not	print.	Print	from	Acrobat,	not	the	browser	If	the	fillable	form	is	displayed	within	your	web	browser’s	window	be	sure	to	use	the	printer	button	on	the	Acrobat	toolbar	menu	to	print	the	form	instead	of	your	web	browser’s	print	function.	Save	the	file	If	you	experience	problems	printing	PDF	forms	once	you	have	filled	them
in,	save	the	data	file	containing	your	information	to	your	local	drive.	Downloading	and	Saving	the	Form	Save	the	form	to	your	computer	before	attempting	to	complete	it	Fillable	PDF	forms	may	be	completed	and	saved	using	Adobe	Acrobat	Reader	(this	software	must	be	loaded	on	your	computer).	To	accomplish	this	you	must	first	save	the	empty	form
on	your	own	computer:	Position	your	cursor	on	the	form	link	and	click	with	your	right	mouse	button	(do	not	activate	the	link	and	open	the	form)		From	the	menu	that	pops	up,	select	the	Save	target	as…	option	in	Internet	Explorer	or	the	Save	link	as…	or	similar	option	in	another	browser	You	should	then	be	prompted	to	choose	a	location	to	save	the
file	Select	the	location	on	your	own	computer	or	network	and	click	on	the	Save	button	Once	saved,	navigate	to	the	file	Completing	fillable	forms	Fill	out	the	form	and	save	it	using	Adobe	Acrobat	Reader:	Use	the	Adobe	Acrobat	Reader	to	open	the	empty	PDF	form	that	you	saved	on	your	own	computer	or	network	Complete	the	form	On	the	Reader
menu,	go	to	File	>	Save	As	Choose	either	the	PDF	(recommended)	or	Text	format	You	should	then	be	prompted	to	choose	a	location	to	save	the	file	Select	the	location	on	your	own	computer	or	network	and	click	Save	Form	or	Field	Exceeds	Printed	Page	If	you	cannot	see	the	complete	text	of	what	you	typed,	your	text	is	too	long.	You	must	shorten	your
entry	to	the	words	you	can	see,	as	only	visible	text	will	be	printed.	Some	printers	may	require	use	of	the	“Shrink	to	Fit”	printer	dialog	box	to	be	checked	in	order	to	print	the	form	on	a	single	page.	A	.pdf	file	does	not	open	You	clicked	the	link	for	a	.pdf	file	and	the	file	did	not	open.	Adobe	Reader,	or	equivalent	software,	may	not	be	installed	on	your
computer.	Install	the	software	and	try	to	open	the	.pdf	file	again.	Unable	to	view	or	download	a	.pdf	file	using	Adobe	Reader	You	cannot	view,	print,	or	download	a	.pdf	file	in	Adobe	Reader.	To	resolve	this,	modify	your	Reader	PDF	viewer	preferences:	Close	the	browser	Open	Adobe	Reader	On	the	menu	bar,	go	to	Edit	>	Preferences	>	Internet	Under
Options,	make	sure	that	Display	PDF	in	Browser	is	not	selected	The	next	time	you	click	on	a	link	to	a	.pdf	form	or	publication,	it	will	open	in	a	separate	browser	window.	A	.pdf	does	not	print	correctly	or	does	not	print	at	all	You	can	try	to	resolve	the	problem	by	printing	the	PDF	as	an	image.	If	you	are	using	Adobe	Reader:	Click	on	the	print	icon	In	the
Print	dialog	box,	click	Advanced	Check	the	Print	As	Image	checkbox	Click	OK	to	close	the	Advanced	Print	Setup	dialog	box	Click	OK	or	Print	in	the	Print	dialog	box	If	printing	the	PDF	as	an	image	does	not	resolve	the	problem,	try	the	following:	Make	sure	you	are	using	the	latest	printer	driver	for	your	printer	Try	printing	to	a	different	printer
Download	the	file	again	to	your	hard	drive	and	print	Refer	to	your	printer	manual	for	further	assistance	Unable	to	use	Google	Chrome	and	Safari	PDF	viewers	In	some	cases,	the	PDF	viewer	is	embedded	in	the	browser	itself.	Below	are	solutions	for	resolving	problems	with	Google	Chrome	and	Safari	viewers.	Unable	to	use	the	Google	Chrome	PDF
viewer	The	Google	Chrome	built-in	PDF	viewer	may	not	allow	you	to	view	a	PDF	or	access	certain	functionalities,	or	functions	such	as	automatic	calculation	may	not	work	as	expected.	To	resolve	this,	follow	these	steps:	Open	Chrome	and,	in	the	address	bar,	type:	chrome://plugins/,	and	then	press	[Enter]	Scroll	down	to	the	Chrome	PDF	Viewer	Click
the	Disable	link	to	prevent	PDFs	from	loading	within	Chrome	Download	the	files	onto	your	computer	Open	them	in	another	standalone	application	such	as	Adobe	Reader	Unable	to	use	the	Safari	PDF	viewer	The	Safari	built-in	PDF	viewer	may	not	allow	you	to	view	a	PDF	or	access	certain	functionalities.	To	resolve	this,	follow	these	steps:	Close	Safari
Open	Terminal	and	type	the	following:	defaults	write	com.apple.Safari	WebKitOmitPDFSupport	-bool	YES	Restart	Safari	Click	on	a	PDF	to	download	it	to	the	Downloads	folder	Change	the	default	PDF	viewer	in	Firefox	Firefox	users	may	also	wish	to	change	their	default	viewer	to	Adobe	Reader.	Open	Firefox	and	navigate	to	Tools	>	Options	Click	on
the	Applications	tab	Under	Content	Type,	scroll	down	to	Portable	Document	Format	(PDF)	and,	from	the	Action	dropdown	menu,	select	Use	Adobe	Reader	Close	the	Options	tab	or	window	This	article	will	help	you	diagnose	and	resolve	common	issues	when	uploading	PDF’s	or	other	document	types	via	DocuSign’s	web	applicationNotes:	The	issues	and
solutions	presented	here	are	meant	for	troubleshooting	issues	when	uploading	documents	using	DocuSign's	web	application.	If	you	are	having	issues	with	document	upload	via	API,	please	see	the	documentation	resources	available	at	the	DocuSign	Developer	Center	.Secondly,	before	reading	on	please	ensure	the	file	you	are	uploading	is	supported	by
DocuSign.	Please	see	Supported	File	Formats.Jump	to	a	known	issue:	Issue:	Document	Upload	Error	or	An	Error	Occurred	"Error	uploading	[filename].	An	Error	Occurred."	Cause:	The	document	is	corrupted	Your	file	may	simply	be	corrupted—meaning	there	are	metadata	issues	in	the	file	which	occurred	during	the	original	document	generation,
scanning,	or	some	other	conversion	process	has	produced	an	invalid	PDF	(i.e.	one	that	doesn’t	conform	to	PDF	structure	standards).	Solutions	Save	as	a	new	PDF	file:	Programs	such	as	Adobe	Reader®,	Adobe	Acrobat®	and	Foxit	Reader®	have	a	built	in	ability	to	correct	any	PDF	structure/metadata	issues.	Simply	opening	your	PDF	and	saving	it	as	a
new	file	will	remedy	this.	Print	the	document	to	a	new	.PDF:	This	option	is	supported	by	owners	of	Adobe	Acrobat	Professional®	(paid)	or	Foxit	Reader®	(free).	You	can	do	this	by	opening	the	file	in	either	program,	going	to	File	>	Print,	and	selecting	“Adobe	PDF”	or	“Foxit	PDF”	as	the	printer.	Choose	the	option	to	"Shrink	to	Printable	Area"	and	click
Ok.	This	will	“print”	the	document	to	a	new	.PDF	file	and	reduce	the	file	size.	Keep	in	mind	that	if	you	have	active	form	fields	in	your	document,	they	will	be	flattened.	Detailed	instructions	can	be	found	here.	Use	.PDF	optimization:	This	is	a	tool	included	with	Adobe	Acrobat	Professional®	(version	8	and	up)	which	will	re-sample	and	compress	the
document,	resulting	in	a	reduced	file	size.	If	you	do	not	have	this	tool,	then	you	will	need	to	re-scan	the	document	using	the	tips	above	or	use	a	free	online	optimizer--though	we	do	not	recommend	uploading	confidential	documents	to	such	free	services		Use	the	DocuSign	Print	Driver	to	upload	the	document	The	Print	Driver	is	a	useful	tool	provided	by
DocuSign	which	often	remedies	this	problem	as	well	as	many	other	file	corruption	issues.	This	tool	allows	you	to	send	the	document	to	a	DocuSign	envelope	directly	from	your	.PDF	or	word	processor	software.	Cause:	The	document	contains	macros	Macros	are	commonly	used	in	Microsoft	Word®	and	Microsoft	Excel®	documents.	While	documents
with	macro-intended	file	extensions	are	supported	(i.e.	.xlsm,	.docm,	.pptm)	and	macro-enabled	documents	may	upload	successfully,	DocuSign	does	not	technically	support	documents	with	macros.	You	can	check	to	see	if	your	document	contains	macros	by	opening	the	document	in	its	respective	program	going	to	View	>	Macros.	Solutions	Remove	the
macros:	Open	the	document	in	its	respective	program,	go	to	View	>	Macros	and	delete	them.	Save	the	file	as	a	PDF	before	uploading:	This	is	accomplished	by	the	Save	As	function	in	Microsoft	Word®	and	Microsoft	Excel®.	Cause:	Document	is	password	protected	or	secured	There	are	two	passwords	that	affect	a	PDF	document.	Both	are	optional;	a
PDF	document	may	have	one,	both,	or	neither.	Unfortunately,	a	variety	of	adjectives	exist	to	describe	these	passwords;	there	is	no	consistency	in	usage.	These	are:	the	access	(a/k/a	read,	"document	open,"	or	user)	password,	necessary	in	order	to	be	able	to	decrypt	and	open	the	document;	andthe	owner	(a/k/a	edit	or	permissions)	password,	needed	in
order	to	change	permissions,	or	to	create,	update	or	delete	the	access	password.	(Permissions	include	the	ability	to	print	the	document	or	make	changes	to	it.)	DocuSign	does	not	support	access-password	protected	documents.	If	you	try	to	upload	such	a	document,	you	should	see	a	specific	error	stating	"this	file	is	password	protected.""Error
uploading	[filename]:	Unable	to	load	the	document	([DocumentId]:	Password	Protected	[filename]).	Document	is	password	protected,	please	remove	password	protection	before	using	the	document."Note:	You	may	only	see	general	error	message	(pictured	previously).Note:	DocuSign	*does*	support	PDF	documents	containing	owner	passwords	and
custom	permissions	settings.	Solutions	The	following	steps	depict	a	third-party	product,	and	may	not	match	your	personal	experience.	If	these	steps	do	not	work,	please	consult	the	help	documentation	for	your	preferred	PDF	Editor	program	for	further	assistance.	Remove	the	access	password	protection:	Open	the	document	in	the	program	which
created	it.	Under	its	respective	security	options,	remove	the	access	password.	For	example,	in	Adobe	Acrobat,	go	to	File	>	Properties	>	Security	(or	type	Ctrl-D).	By	pressing	"Change	Settings,"	you	can	remove	the	access	password	by	unchecking	the	box	labeled	"Require	a	password	to	open	the	document."	(If	the	document	has	an	owner	password,
you	must	supply	it	to	this	dialog	in	order	to	make	changes.)			Issue:	Timeout	during	upload	or	an	error	regarding	file	size	"Error	uploading	[filename]:	File	exceeds	size	limit	of	25MB."	Cause:	Document	file	size	is	too	large	The	file	size	limit	for	a	single	document	uploaded	to	DocuSign's	web	app	is	25MB	(25,000KB).	However,	you	may	encounter
timeout	issues	with	documents	as	small	as	5MB	(5,000KB),	depending	on	your	internet	connection.	You	can	check	the	file	size	of	your	document	by	locating	it	on	your	computer,	right-clicking	and	selecting	Properties.	Best	practice	is	to	keep	the	file	size	under	5MB	(5,000KB).Note:	This	limit	is	enforced	in	all	web	upload	features.	Therefore	you	may
see	similar	errors	when	uploading	a	Signer	Attachment	during	signing	or	from	an	external	source	(i.e.	Box,	DropBox,	Google	Drive,	OneDrive)			Solutions	Adjust	your	scanner	settings:	Make	sure	you	are	not	scanning	in	“full	color”	or	“photo	quality.”	Grayscale	is	normally	acceptable	but	Black	&	White	is	even	better.	If	you	must	use	color,	adjust	the
resolution	down	to	100	to	200	dpi	(sometimes	called	“ppi”).	Most	scanners	even	have	a	have	a	preset	setting	called	“Document	Quality”	which	will	set	these	options	for	you.	Try	solutions	from	Issue	#1.	Issue:	Broken	thumbnails,	pages	won't	render,	"page	cannot	be	displayed"	Your	document	uploads	successfully,	however	the	page	thumbnails	show
broken	icons	and	in	the	tagging	window	or	during	signing,	the	pages	do	not	render	or	you	see	a	red	box	with	the	error	"This	page	cannot	be	displayed,	please	clear	your	cache	and	try	a	refresh."	Cause:	Document	dimensions	are	too	large	Some	scanners	have	a	tendency	to	“blow	up”	or	increase	the	dimensions	of	a	printed	document.	This	can	cause
rendering	issues	in	signing	and	sending.	You	can	diagnose	this	problem	by	opening	up	the	document	in	the	program	that	created	it	and	looking	at	its	properties.	Look	for	the	dimensions.	Are	they	outside	of	standard	document	page	sizes?	Another	way	to	check	is	adjusting	the	zoom/view	so	you	can	see	one	page	as	a	whole,	then	looking	at	the	zoom
percentage	value	needed	to	get	you	there.	If	the	percentage	reads	less	than	75%	(commonly	somewhere	between	30%-50%)	then	that	means	the	document	far	too	large	in	dimension.	Solutions	Update	the	software/drivers	for	your	scanner	and	rescan	the	document:	Updates	can	be	found	in	the	support	section	of	the	manufacturer’s	website.	Make	sure
you	have	the	latest	software	and	drivers	available.		Adjust	your	scanner	settings:	Set	the	default	page	layout	properties	to	ensure	your	scanner	is	saving	the	file	in	a	standard	document	size.	Try	solution	1	from	Issue	#1.	Cause:	Layered	images	and/or	annotations	PDFs	contain	layers.	Sometimes	this	poses	a	problem	in	the	rasterizing	of	the	page
image.	Non-PDF	documents	with	images	can	also	cause	this	issue.	Solutions	Try	solution	2	from	Issue	#1	to	"flatten"	the	file	and	remove	the	layers.	Issue:	PDF	form	field	data	is	missing	When	uploading	a	PDF	with	form	fields	and	choosing	Apply/Assign,	some	form	data	is	missing	in	the	resulting	DocuSign	fields;	or	when	choosing	Cancel/Flatten,	the
field's	value	is	lost.Dynamic	XFA	PDFs	will	automatically	be	rejected.	You'll	see	the	following	error.	Cause:	PDF	is	an	Active	XFA	Form	XFA	PDFs	are	form	fillable	PDFs	produced	by	popular	applications	such	as	Adobe	LiveCycle®	and	Thunderhead®.	While	either	Static	or	Active	XFA	PDFs	will	upload	successfully,	DocuSign	only	supports	XFA	PDFs
that	are	rendered	as	“Static.”	DocuSign	will	display	a	warning	upon	uploading	such	a	document	and	you	may	lose	some	form	field	recognition	and/or	field	values	altogether.	Solutions		Flatten	the	PDF:	If	you	do	not	intend	to	convert	the	PDF	fields	to	DocuSign	fields,	try	solution	2	from	Issue	#1	to	"flatten"	the	file	and	data	first.	Convert	to	Static	XFA:
Use	the	application	which	created	the	PDF	and	save	it	as	a	Static	XFA	instead	of	Active.	Issue:	PDF	form	fields	load	vertically	(aka	appear	rotated	180°)	When	uploading	a	form	field	PDF	and	choosing	Apply/Assign,	all	fields	converted	to	DocuSign	fields	appear	vertical	as	if	they	have	all	been	rotated	by	the	system.		Cause:	PDF	is	in	landscape	mode	or
appears	to	be	in	portrait	mode	but	its	pages	actually	have	rotation	properties	Some	PDFs,	most	often	those	in	landscape	mode	have	rotation	properties	in	their	pages	and/or	fields	themselves.	This	is	done	to	make	the	PDF	more	easily	viewed	and	filled	out	within	a	given	reader	program.	DocuSign	does	support	landscape	documents.	However,	to
remain	consistent	across	the	many	different	PDF	types	a	given	customer	may	upload,	DocuSign	does	not	change	the	orientation	of	fields	/	pages	when	converting	based	on	the	file's	underlying	orientation	properties.		Solutions	While	DocuSign's	tagger	allows	rotation	of	document	pages	once	uploaded,	we	do	not	rotate	the	fields,	nor	adjust	the	text
rotation	within	them--text	field	values	are	always	entered	left	to	right,	right	side	up.Options	to	fix:	Correct	the	orientation	prior	to	upload	using	a	PDF	editor	or	the	tool	that	created	it.	Rotating	the	pages,	changing	orientation	properties	of	the	fields	and	re-saving	the	file	in	portrait	mode	is	your	best	bet.Manually	re-size	and	reposition	the	fields	within
the	tagger	Resources	Supported	File	Formats	-	New	DocuSign	ExperienceDocuSign	REST	API	Documentation	-	Resource	LimitsSOAP	API	Guide	-	File	Limitations	Still	need	help?	Visit	the	Community	DocuSign	customers	ask	and	answer	questions	for	each	other.Go	To	the	Community	Get	Support	A	customer	service	rep	can	help	answer	your
questions.Get	Support
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